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System Requirements

BoxCar requires a 386 (or better) processor with at least four Megabytes of RAM
running Windows 3.1 or later. It must also have at least one free Com port (serial).
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BoxCar without a Mouse

This version of BoxCar allows the user access to most of BoxCar’s features even if the
PC does not have a mouse, or if the mouse serial port is being used for the logger inter-
face connection.

Alt and the underlined letter

The menu bars are accessible using Alt and the underlined letter from the top of the
menu bar. The commands on the individual menus are accessible by pressing the under-
lined character of the command while the menu is displayed.

Tab between items in dialogs

You can use the Tab key to move between the items in a dialog box. (The arrow keys can
be used within a group of radio buttons in the dialog box while Tab will move between
the groups.)

Use the arrow keys to change values
In dialog boxes that have drop down lists, the arrow keys can be used to scroll through
the list; however, the list will not drop down.

Space bar changes the selection in check boxes

By pressing the Alt key and the underlined character in a dialog box you can toggle the
check box of that item. The space bar allows you to select or deselect a check box on an
active item (the active item has a small box appear around it).

Selecting part of a plot

Use the arrow keys to move the cursor to a corner of the section of the plot you want to
expand. Hit Enter, and then use the arrow keys to select the opposite corner. Hitting En-
ter now establishes the selection. Use F7 to zoom in on this part of the plot.

DOS Utilities and H8 Pro Archive Reader

The DOS Utility was developed to allow users to perform the basic functions associated
with a logger: launching, reading out, and saving files. The Utility is small enough to
run on most older machines and portables with minimal memory. The Utility also allows
users to open previously saved data files, view data in table format and export to a text
file. For more information about this program, read the file utilhelp.txt within the
LOGUTIL directory of your BoxCar Installation directory.

The Archive Reader Utility is a Windows 95/98/ME/NT/2000 application which allows
you to retrieve and save data from the last eight deployments of any HOBO Pro Series
data logger. Consult the HOBO Pro Series logger User’s Manual for information about
the archiving feature. For more information about the Archive Reader, please refer to
the readme.txt file in the ARCHREAD directory of your BoxCar Installation directory.

BoxCar without a Mouse/DOS Utilities 27

File Management

Note: File options not described here have been cov-
ered earlier in this manual. m

Cloze
Open
The open option allows you to view previously Save ...
offloaded BoxCar compatible files. Export »
Close Prirk... Cuk+P
Select Close to close the active file. It will also prompt Puirk Setup...
you to save an untitled file.
Preferences...
Save As Wiew Readoul Log
Select Save As to save the active file with a new Exit AllsFd
name.
Exit

Exit BoxCar, saving all untitled files.

Help

Select Contents on the Help menu to open the help file for BoxCar.
Step through the help file, using the tab key or mouse. Use the re- —
turn key or mouse button to select underlined blocks for additional bl

details. et Rt culel

Abhout.

Testing Your Communications Port

Select Test Port on the Help menu to determine the reli- —
ability of your computer’s communication port and/or the
serial cable. Click the radio button that corresponds to the
port you want to test and press the Test button. Once you
are finished, press Done. The Instructions box contains
more information about the test.

26 File Management/Help / Testing Com Port
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Thank you for purchasing Onset products. Our loggers and software are designed to be
easy to use. For a quick start, please refer to the instructions on page 6. You can then
use the BoxCar User’s Manual or the on-line help feature for a complete description of
software capabilities.

Software License Agreement

IMPORTANT, PLEASE READ CAREFULLY: THIS IS A LEGAL AGREEMENT BETWEEN
YOU AND ONSET COMPUTER CORPORATION. BY INSTALLING, COPYING, OR
OTHERWISE USING THE SOFTWARE PRODUCT, YOU ARE AGREEING UNCONDI-
TIONALLY TO BE BOUND BY THE TERMS OF THIS LICENSE AGREEMENT, EVEN IF
THIS LICENSE AGREEMENT IS DEEMED A MODIFICATION OF ANY PREVIOUS
ARRANGEMENT OR CONTRACT. IF YOU DO NOT AGREE TO THE TERMS OF THIS
LICENSE AGREEMENT, DO NOT INSTALL OR USE THE SOFTWARE PRODUCT AND
PROMPTLY RETURN THE SOFTWARE PRODUCT TO THE PLACE YOU PURCHASED
IT FOR A FULL REFUND.

1. For the purposes of this License Agreement, “Software” or “Software Product” refers
to the computer software and associated media, printed materials, and “online” or
electronic documentation, including any and all executable files, tutorials, help files,
utilities, and other files that accompany this product.

The Software Product is owned by Onset Computer Corporation and is protected by
United States copyright laws, international copyright treaties, and all other applicable
national laws. Title, ownership rights, and intellectual property rights in and to the
software shall remain with Onset Computer Corporation. The Software Product is
licensed, not sold. There is no transfer to you of any title to or ownership of the Soft-
ware, and this license shall not be construed as a sale of any right in the Software. You
may not make additional copies of the software, except as provided for in paragraph
number 2 below.

2. Grant of License. This Onset license agreement grants you to install and use one copy
of the enclosed version Software Product on a single computer. The primary user of the
computer on which the Software Product is installed may make a second copy for his or
her exclusive use on a portable computer and/or home computer.

3. Other Restrictions. You may not reverse engineer, decompile, or disassemble the
Software Product or make any attempt to discover the source code to the Software
Product. Except as expressly permitted in this License Agreement or with written
permission from Onset Computer Corporation, the Software may not be used, copied,
redistributed, retransmitted, published, sold, rented, leased, marketed, sublicensed,
assigned, transferred, altered, or modified.

The Software Product is licensed as a single product and its component parts may not be
separated for use on more than one computer.

Software License Agreement 3
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4. Support. Support for the Software Product is provided by the company from which
you purchased it.

5. Liability. Other than as permitted by applicable law, in no event shall Onset
Computer Corporation or its suppliers be liable for any direct or indirect damages
whatsoever, arising out of the use, or inability to use this Software Product. In any case,
Onset Computer Corporation and its supplier’s entire liability is limited to the amount
actually paid by you for the Software Product.

Trademarks

Onset®, HOBO®, StowAway®, TidbiT®, and BoxCar® are registered tradmarks and Optic
Shuttle™, Optic Base Station™, Optic Coupler™, TidbiT® Coupler™, and HandCar™ are
trademarks of Onset Computer Corporation.

All other trademarks are the property of their respective companies.

4 Software License Agreement
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Changing the User Preferences

Preferences from the File menu allows you to customize
some aspects of the BoxCar program. Tl
Dok Sera Fort o

Default Serial Port ;

. . |- Data Tima Format
This drop box allows you to choose the default communica- Dom B2
tions port that BoxCar will use when trying to readout and Tine  112R29AM G |
launch your loggers. o

| I Showwslcome Scisen

Change (Date/Time Format) | ¥ 30 Broy Rackpounca

This area shows the currently selected date and time for- ‘ g
mat. The Change button allows you to modify these set- o

tings. Please see the section on changing the date and time
settings below.

Date/Time Settings Dister/Time Seitings

Here you can change the date Dt Gder S ledzan— - Yeu Fama T Famd—
order, specify if you want leading = Mooth, Day, Yee I Merth | % 20  24How
zeros on your date, a 2 or 4 digit ™ Diag, Month, Yen I Day ! r~ 4Dige & 12Hou
year format and a 12 or 24 hour  Year, Month, Day = Howr o

time format. You can also select T == P

your date and time separators. A Date [Slaeh i) =] Time [Conl] = | Tine 1001-334M
sample of your current selections

are shown. The Use Control Panel I s Coneol Panel Seitngs

Settings check box toggles whether
or not BoxCar will use Windows’
date and time settings for the date
and time.

[ ] Cacel | Hel

Show Welcome Screen
This checkbox toggles whether or not a welcome screen is displayed when you enter
BoxCar.

3D Gray Backgrounds

This check box toggles the 3D gray backgrounds. This button only affects the appear-
ance of windows under Windows 3.1. Under Windows 95, all the dialog boxes will auto-
matically be shaded gray.

Language
If multiple languages are available, the language box lets you switch the language used
by BoxCar. The new language will not take effect until you press the OK button.

Changing User Preferences 25

Printing

Printing your graph
To print a graph, file information, or the tabular data - Ophiore ——————————————
itself (or any combination of the three), select Print I Flejrlomalion 1 pagel

under the File menu. Select the check boxes corre- ¥ Greph[1 gage) tancal |
sponding to the information that you would like | I Logge Diata (18 pages] Hob

printed. The graph will always be blown up to fit a full
page, regardless of the size on the screen. The File In-
formation option will print the same information shown in the File Information box (ac-
cessible from the View menu). The Logger Data option will print the date and time (in
the format specified in the Date/Time Preferences) and the value (in the current dis-
played units) of each point in the file. The page orientation, Portrait or Landscape, will
be the same for all the options selected (see below).

Print Setup

Selecting Print Setup from the File menu displays the Print Setup dialog box. From
here you can choose the paper size, paper orientation, what printer you are using, etc.
Additional options (resolution, scaling, print quality, etc.) may be available depending on
the attached printer.

The Tool Bar

The buttons on the Tool Bar allow quick access to some of the functions. The Message
Bar at the bottom of the window describes these when the cursor is placed on them.

Open: Allows you to view previously offloaded BoxCar compatible files.

Save As: Saves the currently displayed file using a different name.

Microsoft Excel Export Setup: Allows you to export data in Microsoft Excel format.
Lotus 1-2-3 Export Setup: Allows you to export data in Lotus 1-2-3 format.
Custom Export Setup: Allows you to export data in a customized format.
Print: Allows you to print the currently selected plot.

Copy: Copies the plot as a bitmap to the clipboard.

Launch: Displays the launch dialog box.

Readout: Offloads the data from the currently connected logger.

Optic Shuttle Readout: Offloads data files from the Optic Shuttle.

Connect Points: Draws a line between each point on the plot.

Mark Points: Displays a small circle around each data point.

Alarm Lines: Display the high and low alarm limits (if set) for StowAway plots.
File Information: Displays additional information about the current plot.
Selection Tool: This is the default general purpose selection cursor.

Zoom Tool: Allows you to select an area of a plot and magnify it.

Help: Brings you to the contents of the help file.

24 Printing/ Tool Bar
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Installation

To install BoxCar software on your hard drive, insert the BoxCar diskette into the drive
on your computer. For Windows 3.1, go to Program Manager, choose Run from the File
menu, or for Windows 95/98/ME/NT/2000, click Start then choose Run; type a:\setup
(or b:\setup) and select OK. The installer prompts you for the directory (BOXCARS is
the default) and installs the program and the help file.

BoxCar is a 16-bit application. Operating systems such as Window 95, Windows 98/ME,
and Windows 2000 run 16-bit programs by means of a 16 bit subsystem called Windows-
on-Windows (WOW). If you experience difficulty running BoxCar in 32-bit Windows,
check your system for the following files and make sure they are not corrupted:

wowexec.exe
wow32.d1l

For more datails, search for WOW on the Microsoft® website at http://www.microsoft.com.

Connecting to your PC compatible

The logger is connected to your computer with a PC-3.5 interface cable. It is designed to
connect directly between the PC compatible’s 9-pin Com port (serial) and the data
logger. (A 25-pin to 9-pin adapter may be needed if your computer does not have an
available 9-pin port). For information on connecting to USB ports see our FAQ
(Frequently Asked Questions) page at http:/onsetcomputer.com/Support/HS_Support/
4218_FAQs.html for compatible USB to serial adapters.

The interface cable must be connected to a working serial port. If the serial port was
recently used for a modem or a mouse, the port might still be configured as such. After
removing a mouse, reboot your system. Use the Communications Port Tester (see page
26) in BoxCar to make sure that the serial cable and serial port work correctly.

Set your clock and start BoxCar

Before starting BoxCar, make sure your computer’s clock is set to the correct time be-
cause the logger will use your computer’s clock to set its own internal clock. To start
BoxCar for Windows, double click on the BoxCar icon.

Installation 5

W I .

Quick start

Follow this procedure to get your HOBO or StowAway connected and displaying
data. Details on programmable options follow this section.

1. Connect the interface cable to an open Com port on the back of the computer.

2. Connect the other end of the interface cable to the logger.

3. Select Launch under Logger on the menu bar.

4. Press the Start button. The logger will be launched with default settings
and start recording data.

5. Wait a few seconds and select Readout under the Logger menu. The data
recorded by the logger will be offloaded and displayed on the screen as a plot;
you will be prompted to save the file.

Launching your logger

To launch a logger, connect it to your PC as described
above, then select Launch from the logger menu. BoxCar
determines what type of logger is connected and displays a
launch dialog box specific to the type of logger.

Beadout CilsR
HOBO Shuitle Readout Cul+R

Though each logger type has its own specific features, all Optic Shutlle Readout  Clrksl)

launch dialogs have the following standard features in
common.

Common Features

The Start button loads the
information in the Launch dialog box
into the logger and starts it. The Cancel

HOBO TEMP (C) 1956 ONSE T COMPUTER CORP. S/ 124501
Dater 4/30/97 02120 AM Reading 221°C

il

button stops the Launch and reverts to Descspton: HOBO Tewp H
the old settings in the logger. Il Dol [55ecnsmm ¥
Moansement Link Tempershae ['C) -|

The first line of information in the dialog
box to the right, identifies the type of log-
ger and its Serial Number. The Date
displays your computer’s current date
and time. If the date is not correct,
consult your Windows manual on how to
change your computer’s date or time. The
Advanced Options toggle arrow shows
and hides additional options. For logger
specific launching features, refer to the
pages that follow.

™ Advanced Optiona..

I Mahap avound when bl [reerwie okdest data]

6 Quick start/Launching
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Sample
This box displays a sample of what your exported data will look like. Always be sure to
look at this box before you export to make sure that it looks correct.

Export

This button will export the data to a text file of your choice. Some spreadsheets are
not able to import files with more than 16,000 points. If your data file contains
more than 16,000 points, BoxCar will ask you if you want to export to multiple files
(see Multi-file).

HOBO TEMP. RH. LI. EXT [C) 1996 ONSET S/H1E7
Humber ol Data Poirlz k:nl
Hurnber of Pz Per File: IISSE

Hurnbers wil be appendad o the end of the fls name.

Multi-file

This button will bring up a dialog that allows
you to split up the data into multiple text files
of a size that you specify.

To choose how many points will be placed
in each file, simply type the number of
points in the text box and click the OK
button. To abort the operation, hit the
cancel button. The files will be plain text,
numbered sequentially. The file name you entered in the save dialog will have
numbers appended to it. For example, if you export the file 'test.dtf' to four separate
files, the files will be named 'test0000.txt,' 'test0001.txt,' 'test0002.txt,' and
'test0003.txt' automatically.

Cancel
This button will close the export dialog and revert to the previous export settings.

NOTE: Exported files cannot be read back into BoxCar.

Working with an Exported File

To work with an exported file, start the intended program, e.g. Lotus 1-2-3 or Excel, and
import or open the file that was saved with the .TXT extension. (If you are having prob-
lems finding the file which was saved, please refer to the manual which came with your
computer).

Exporting data 23

Exporting data continued...

Custom Date Settings

From this dialog, you can choose the order of the month,
day, and year, and choose the character that is used to
separate them. Clicking the OK button will accept the
options, while clicking the Cancel button will revert to
the previous settings.

Custom Date Settings =]

€ Dy, Morih, ear
" Yma, Month, Day

Date/Time Separator

This box allows you to select the character that will separate
the date and time in the spreadsheet. If you wish to have
both date and time in a single column, you should set this option to 'Space.' To separate
the columns, you may (for most spreadsheets) choose any of the other options available
in this box (comma, semicolon, or tab).

Time Format

This box allows you to choose the format in which the time is displayed in your exported
data. For most spreadsheets, the default value of Hour:Minute:Second (with half sec-
onds) will be acceptable. Again, for compatibility’s sake, we have included a variety of
other options, most of which are self-explanatory. As with the Date Format, the old Lo-
tus and old Excel format have been included.

Change Time Settings
This button will allow you to customize the time

Export Time Settings

that is displayed when you export data. The ra- ;";Ermu

dio buttons choose between 24-hour (military &

time) and 12-hour formats. The separator drop " 12Hou | el |
box allows you to choose the character that will

separate the different parts of the time. The OK Sopmalor [Coor() =] Hoe |
button will accept the new settings, and the ~Sample

Cancel button will negate them. 08:44.02 |

Data Separator
This drop box chooses the character that will be used to separate the columns of data
points. Your choices are comma, semicolon, tab or space.

Units/All Units

This box allows you to select the units that will be exported with the current settings. If
a unit is highlighted (usually blue or black), it will be exported. Again, you can check the
sample box at the bottom of the dialog to see if the correct units are going to be exported.
The 'All Units' check box will select all available units for exporting. For H8 family log-
gers, the channel number(s) will be displayed in parenthesis after the unit in the export
file. A * preceding the channel number denotes the sensor was selectable during launch
(see Launching).

22 Exporting data
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Launching HOBO 2K loggers

N W | S

Launching StowAway loggers

Reading T

To check the current reading of the logger,

examine the Reading field. Readings are :r;nmmn;:::‘risn SR n..::'f-"c [

displayed in the currently selected Lo |

Measurement Unit. Descrphon [HDED Tero Heb |
IrvelDusiork  [055ecnsin 3]

Description HessenentUne  [Tompmgie 10 2]

Enter up to forty characters of text in the
Description field. This text is sent to the
logger when you click Start and is dis-

™ Advanced Opeonz..

I~ \wlhaps avound when bl [ovemete oidest data)

played below the time axis on the graph.
HOBO 2K Launch Dialog Box

Interval (Duration)

Select the Interval (time between measurements) and the Duration (amount of time the

logger will collect data) from the interval box.

Add Custom Interval

To create your own custom interval, select
‘Add Custom Interval’ at the bottom of the
interval scroll box. You can designate as

2 Sec (4 Hiz 24 Min] ﬂ
4 Hrs 1324 Days| -

ST Custom Interval B

b Hrs [19595 Days|

s E}élig;‘:’ EnlesIntervat [05 #fz0fon | =] many custom intervals as you require (be-
9 Hrs (2973 Daws) tween 0.5 seconds and 9 hours). Custom In-

add Custom Inienval | [F0R ) Cancel | tervals are saved for the current session

but disappear when you quit BoxCar.

Measurement Unit

Click the Measurement Unit box to choose the units displayed in the Reading Field. The
Measurement Unit you set here is also used as the default unit at readout. A tempera-
ture graph can be viewed in degrees Fahrenheit or degrees Celsius. BoxCar also lets you
change the units after reading out data.

Wrap Around When Full

Click Wrap Around When Full to set the logger to record continuously, overwriting the
oldest points when it is full. When full, the logger continues logging until interrupted by
a readout or launch. On readout, the most recent points are read out. If Wrap
Around When Full is not checked, the logger stops when its memory is full.

Start

Click Start when you are satisfied with the settings. Do not unplug the logger from the
interface cable until BoxCar has indicated that the launch has been completed. Please
note: Launching your logger will overwrite the previously recorded data. Confirm a suc-
cessful launch by watching for the logger’s LED to blink. Consult the logger’s User’s
Manual for more information on the LED status signals.

Launching 7

Reading

To check the current reading of the logger,
examine the Reading field. Readings are
displayed in the currently selected Measurement
Unit.

Stowewany TEMP [C) ONSET 35C 10 460 LLAE ] :: [
Dsher £/2/7 1 2TIRU

Description
Enter up to forty characters of text in the De-

% fcvanced Opion:

™ Yo s wheors fuf forvervis ciest

scription field. This text is sent to the logger when  #oassss [ 40 457 ‘I‘JF Fr
you click Start and is displayed below the time " Tnogma it Uulee e
axis on the graph. ;’;‘*‘"J"“" P Lo
T Narpsty
B B 20|17 iy

Interval (Duration)

Select the Interval (time between measurements)
and the Duration (amount of time the logger will
collect data) from the interval box.

StowAway Launch Dialog Box

Add Custom Interval
To create your own custom interval, select
‘Add Custom Interval’ at the bottom of the in-

2 Sec (4 Hiz 24 Min] ﬂ
4 Hrs 1324 Days| .

EIUANEEDEE I Custom Interval E|

GHrs 19350 -
7 Hrs (23170 Enteelterat [35 [0 100 =] terval scroll box. You can designate as many
%nrs %3;{; custom intervals as you require (between 0.5
- 139 Fas T

seconds and 9 hours). Custom Intervals are
saved for the current session but disappear
when you quit BoxCar.

Add Custom Intesval, [

Cencel |

Measurement Unit

Click the Measurement Unit box to choose the units displayed in the Reading Field. The
Measurement Unit you set here is also used as the default unit at readout. A tempera-
ture graph can be viewed in degrees Fahrenheit or degrees Celsius. BoxCar also lets you
change the units after reading out data.

Wrap Around When Full

Click Wrap Around When Full to set the logger to record continuously, overwriting the
oldest points when it is full. When full, the logger continues logging until interrupted by
a readout or launch. On readout, the most recent points are read out.

If Wrap Around When Full is not checked, the logger stops when its memory is full.

Delayed Start

To postpone logging for up to three months after launching your logger, click Delayed
Start, then enter a specific start date and time in the fields provided. The format you
use to enter date and time will match the format you selected in BoxCar Date/Time
preferences.

When delayed start is enabled, the logger does not start to record data immediately
when you click Start. Rather, you will see the logger flash dimly (approximately every
four seconds) until it reaches the start time specified, then data logging will begin.

8  Launching
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Exporting data

BoxCar exports data to a text file which can be
imported by most spreadsheet programs, such as O oo
Microsoft Excel and Lotus 1-2-3. Select Export Do

under the File menu and select one of the

following options. Fol

Microsoft Excel Format and S i
Lotus 1-2-3 Format e —

If you choose the Microsoft Excel or e Readou Log

Lotus 1-2-3 options under the Export submenu, Bl BboFd
most of the controls in the export dialog will be un-
available, and BoxCar will instead choose the most appropriate format for you. You can,
however, still choose the units that you want to export. Please see the Units/All Units
section on the next page for an explanation of choosing units.

Custom Format

You can choose your own Custom Setup by se- [EriFr I |
lecting the Custom option available under e |
the Export submenu. The Export Setup dia- | Dote Fw": o Motaties o)
log contains a variety of options to fully cus- [ el

tomize your exported data. As you change the | Pasime S epRmor] Coaco &
various options available, a sample at the bot- | Tove Fomat [Hittinse= 7]
tom of the dialog shows a preview of the ex- [ =

ported data reflecting your current settings. | Qorge Tie Setoge.. |
The options available in this dialog are shown | Diata Satings

to the right and a detailed explanation of | Dot Separaton Tab -
these options follows. | Lrits: I AlUnds

Date Format

This box allows you to choose the format in
which the date will be displayed. For most

spreadsheet programs, the default option will Sample

suffice. However, for compatibility’s sake, i;‘;:::mm;"“‘;;:"ﬂs RH ¥)01.2)

there are two other options: Day Number (day | ;

of year, 0-365) and Old Lotus/Excel (for ver- L R (5848

sions of Lotus 123 prior to version 5 or Epot. | Hbfie. | Cocel | Heo |

Microsoft Excel prior to 4.0). You can also
choose to have no date included in the export.
In addition, you may specify your own custom date format by choosing the 'Custom' op-
tion. The letters in parentheses after the word Custom indicate the current custom for-
mat. When you select the custom option, a dialog will appear that will allow you to cus-
tomize the date format.
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Viewing multiple data files

BoxCar allows you to have a large number of S T
files open to view at one time. The Window
menu gives you some tools to help you man-
age these windows.

Cascade Windows

Automatically aligns each window title so
that the titles of each open plot are displayed.
This arrangement allows you to read all of the
file names and look at large plots of data by
simply clicking on the name corresponding to
the desired plot.

Tile Windows

Automatically reduces the size of each open
plot and displays each in equal size. Tiled
windows are all readable at the same time,
however the more you display this way, the

smaller they are. i A T *
Close All

This command closes all plot windows, I
prompting you to name all 'Untitled' files. by _Lf.l;l__],_l__‘i.‘.”'_m”

The File names below the line Rt e
The file names of all open plots are shown in a list below the line in the Window menu.

You can bring any plot window to the front by selecting it from the list or typing Alt+W
and the corresponding window number. This will only work for the first nine windows.

NOTE: Multiple copies of a file can be opened at once. If you do open multiple copies,
each one will have a number after the file name.

Viewing multiple channels

BoxCar can not graph more than one channel per graph. However, there are several
options for viewing multiple channels of a HOBO logger’s data. The first is to open the
graph and use Display Options under the View menu to switch back and forth among
the different measurements. The second is to open multiple copies of the same file. This
will allow you to use the Tile Windows option and see all open graphs at one time.
Another option is to Export the data into a spreadsheet program and use that
program’s graphing capability.

Copying pictures

To copy your graph as a bitmap to the Clipboard, select Copy from the [
Edit Menu or use the Copy button on the toolbar. To copy just a section
of your graph, use the Selection tool to select the area of interest and

then select Copy.

20 Viewing/Copying
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Triggered Start

Select Triggered Start to postpone the launch time of your StowAway logger until trig-
gered. After the logger has been launched, the StowAway will flash its LED dimly every
six seconds until triggered. Once triggered, the LED will flash brightly four times and
then continue to flash brightly every time a measurement is taken.

Delayed Start after Triggered Start  [Foeaedsiat tornmwss [0 e i =]
Selecting both Triggered Start and S

Delayed Start causes the StowAway to I+ Tigpered Stat

delay for a specified amount of time after the trigger has been activated but before it
starts logging. The time format is displayed in the format currently specified in the
Date/ Time Preferences.

Alarm

Alarm, when selected, allows you to see if the StowAway
has recorded a reading outside of a preselected range. The
Alarm reads in the units shown in the Measurement Unit
box. To set the Alarm, just slide the tabs to the desired High and Low values. The
Alarms are off when the High tab is slid all the way to the right and the Low is slid all
the way to the left (the word 'off' will replace the numeric value). You can turn the
Alarms off independently of each other - you may only want a High alarm, in which case
you can just turn off the Low and keep the High on. The various StowAway loggers have
different ways of representing Alarm conditions. Read the individual logger’s manual for
details. The Alarm data can be seen on the graph after readout. Please read the section
in this manual on Alarm Lines in the section Viewing your Data (see page 16).

Multiple Sampling

Multiple Sampling causes the logger to take multiple measurements
during an interval and store only the minimum, maximum, or average
of the readings. In Multiple Sampling mode, the logger takes about 100
measurements, evenly spaced in each interval unless the interval is less
than one minute. For shorter intervals, the logger will measure once
every half second during the interval. Multiple Sampling increases the average current
drain of the logger. To minimize current drain, this feature should not be used

unless needed.

Start

Click Start when you are satisfied with the settings. Do not unplug the logger from the
interface cable until BoxCar has indicated that the launch has been completed. Launch-
ing your logger will overwrite the previously recorded data. Confirm a successful launch
by watching for the logger’s LED to blink. Consult the logger’s User’s Manual for more
information on the LED status signals.

Launching 9
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Launching HOBO H8 (including Pro Series) loggers

Deployment

To view the number of times your logger has s i e Rk ==
been deployed, check the Deployment field. The e
value in this field always includes the current oW {.x e =
deployment, and increases by one every time the T A S gprdiad
logger is launched. T ! w4
HH 1Y 12 x
Description i E o lu/l
T dvaread Opkeea
Enter up to forty characters of text in the De-
scription field. This text is sent to the logger I
P y X 28 Gt o0 il T

when you click Start and is displayed below the
time axis on the graph.

ot et Crarmats 1,2,1.0 Lrsbie Tizatse Charrss |

HOBO H8/Pro Series Launch Dialog Box
Interval (Duration)
Select the Interval (time between measurements) and the Duration (amount of time the
logger will collect data) from the interval box.

2 Gen (4 His 24 Min] = Add Custom Interval

THis (1328 Days] -1 ~ To create your own custom interval, select ‘Add
5 Hrs (1655 Days] Custom Interval’ at the bottom of the interval

6 Hrs (1985 Days] scroll box. You can designate as many custom
7 Hrs [2317 Days) 3l g : : ;

B Emg Do) (GBS [0 @ = | intervals as you require (between 0.5 seconds
3 Hrs (2979 Daws) and 9 hours). Custom Intervals are saved for

dd Custon nerval,— [F0R | o=l | | the current session but disappear when you

quit BoxCar.

Measurement, Channels, and Reading

The Measurement column shows the units available based on the sensors chosen from
the Enable/Disable Channels button. In the example below, the HOBO RH/Temp/Light/
External with all Channels enabled will measure Temperature (°C and °F), RH (%), Dew
Point (°C and °F), Abs Humidity (gm/M3), Uncomp RH (%), Intensity (Lumens),

and Voltage.

The Channels column shows which sensors are i Ehanelt
used to calculate the measurement. For example, mmmmry
Dew Point uses the temperature channel plus the |lemeesarer]
humidity channel to calculate Dew Point, as v |

there is not really a dew point sensor connected.

RaRIRIRD

o~ apa

The Reading column gives the current reading,
updated every second, of the connected logger.

10 Launching
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Zoom Out

Zoom out to the previous plot by choosing
Zoom Out (F8) on the View menu. If
you are using the zoom tool (magnifying
glass), zoom out by clicking the right
mouse button within the graph area.
From the original plot, an additional
level of zoom is possible. If you zoom out
when viewing the original plot (see Origi-
nal Plot), the graph will change to reflect
the logger’s full measurement range.

Tempeeature (€}

Original Plot

To return to the original plot of your
data, choose Original Plot (F9) from the
View menu.

File Information

The File Information selection opens a dialog box that describes the currently active file.
The description is for the entire file and does not change with a zoom. To view the data
in tabular format, click the Show Data triangle at the bottom of the dialog. When you
click on a point in the list of data, if that point is displayed in the current view, a vertical
line is drawn on the graph corresponding to the point. Once the data is visible, click the
Hide Data button to hide the data and the line, if visible. Click the close box to close the
File Information dialog.

2 alaen 811
owm
Sty TEMP () CHEET 384 10 482

113829
R —

knu S
Sty T u:;cmr 36076 480

St Imw 807
ra Tiaw SOST
sorvat DEgel M 115820 Sorglng  Snge

T Pods 4035 L Tencesshae ['F) L~
wan SiThne  SEATO2XETOAM =
{p Shaw Datm Eeifme  SBAT0GSR290AM E
. LI .
T M H
B35 NaxValn w2 3 /
2
g -~
Temcermture (') = e J"l

mnn 2"[[ |00 K00 000 ..EII 'IIII 5500 0000
(M 87 3 Alarm SM 1A
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Viewing your data

BoxCar software displays your data in a graph with the launch

description and serial number of the logger shown below the time v Connect Paints F4
and date X-axis, and measurement units beside theY-axis. The Mak Poirts  F§
options described here are found on the View menu on the main i Uhiss
menu bar. —

Display Options ~~ »
Connect Points —
When Connect Points (F4) is checked (the default), the plot is zz;.?mm;ul :;
drawn with lines connecting each measured data point, yielding a OigndPbt  F3
continuous line for the entire graph. When Connect Points is not ek
checked, each data point is displayed with a single dot. Eile Information

Mark Points

When Mark Points (F6) is checked, each data point is displayed with a small circle
drawn around the point. For sparse data sets, this option makes individual data points
visible.

& alasim il

Alarm Lines

The Alarm Lines option is only avail-
able when viewing the graph of a
StowAway logger with Alarms options
set. When this option is checked, dotted
lines appear on the graph to show the
High and Low alarm values that were
set when the logger was launched.
These alarm areas will be shaded gray
so you are able to tell the difference be- o
tween the alarm (gray) and non-alarm h

——p

Temperoture [°F]

1
20:00 2500 3000 3500 4000 4500 S0.00 5500 OG:00

(White) areas. D8MaE7 08 2000 SM1sEs
Display Options i

Select Display Options to choose LR N v Channels: | Temperature (F)
between any of the available units to Channels: 1 Temperature [T)
display your data. For H8 loggers, an asterisk (*) pre- Channels: "2 Voltage [V)

ceding the channel number denotes the sensor was se-
lectable during launch (see Launching). The HOBO Temp/External logger’s data units
are displayed to the right.

Zoom Selection

Zoom in on any section of a plot by using the selection tool (Arrow) to draw a box around
the section of interest. To zoom, click inside the box or select Zoom Selection (F7) on
the View menu. If you are using the zoom tool (magnifying glass), use the left mouse
button to zoom in on a selection without clicking inside the box first.

18 Viewing your data
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Wrap Around When Full

Click Wrap Around When Full to set the logger to record continuously, overwriting the
oldest points when it is full. When full, the logger continues logging until interrupted by
a readout or launch. On readout, the most recent points are read out.

If Wrap Around When Full is not checked, the logger stops when its memory is full.
Note: The HOBO HS8 Pro Series loggers do not support Wrap Around When Full.

Delayed Start

To postpone logging for up to three months after launching your logger, click Delayed
Start, then enter a specific start date and time in the fields provided. The format you
use to enter date and time will match the format you selected in BoxCar Date/Time
preferences.

When delayed start is enabled, the logger does not start to record data immediately
when you click Start. Rather, you will see the logger flash dimly (approximately every
four seconds) until it reaches the start time specified, then data logging will begin.

Current Enabled Channels

This shows which channels are currently activated (not available for the HOBO H8
Temp and other single channel loggers).

Enable/Disable Channels

To enable or disable channels click the Enable/Disable
Channels button. The dialog box shown at right ap-
pears. Check the box next to the sensor to enable or dis-
able that channel. If your logger has more than one
channel, you will be able to enable or disable

channels for each launch. Max points per channel dis-
plays the number of points that will be stored for each
channel before the logger is full (data memory

divided by number of enabled channels).

To select resolution for HOBO Pro Series loggers see the logger manual.

Note: If your logger has one or more external sensor jacks, you must specify what type of
sensor is connected to each jack or data will not be displayed correctly.

Battery Level

Watch the Battery Level gauge to see the remaining battery capacity.
When the gauge reaches one quarter remaining, we suggest you change
the battery, especially if you plan a long deployment.

Start

Click Start when you are satisfied with the settings. Do not unplug the logger from the

interface cable until BoxCar has indicated that the launch has been completed. Launch-
ing your logger will overwrite the previously recorded data. Confirm a successful launch
by watching for the logger’s LED to blink. Consult the logger’s User’s Manual for more
information on the LED status signals.

Launching 11
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Launching HOBO Thermocouple and
HOBO Carbon Monoxide (CO) Loggers

Eallery Leve!

Deployment

To view the number of times your logger has been de-
ployed, check the Deployment field. The value in this
field always includes the current deployment, and
increases by one every time the logger is launched.

Description

Enter up to forty characters of text in the Description
field. This text is sent to the logger when you

click Start and is displayed below the time axis on " Dnapi e

the graph. Currern Eracied (hamats |23

Interval (Duration)
Select the Interval (time between measurements) and the Duration (amount of time the
logger will collect data) from the interval box.

See the description of HOBO HS8 loggers for information on adding custom intervals.

HOBE 100 T Mrasmosoucis € 000w ]
Do 750100 10 4AN

T

(R T ——
e st s e | e

HOBO Thermocouple Loggers: Measurement, Channels, and Reading

Measurement Channels Reading A unique feature of the HOBO Thermo-
Temperature (°F) 1 78.8 couple logger is that it has multiple mea-
Temperature (°C) 1 26 surement ranges that can be selected.
Temperature (°F) 2 77.5 Channels 1 and 2 represent two different
}ngggmg EE)) g 5232 ranges for the attached thermocouple. The
Temnperature (°C) 3 214 remaining chanr}el 3) dlsplays.the mea-
surement of the internal thermistor.

Refer to the HOBO Thermocouple logger’s User’s Manual for the exact measurement
ranges represented by each channel.

HOBO Carbon Monoxide Loggers: Measurement, Channels, and Reading
The HOBO CO logger has three measure-

Measurement Channels Reading

) ] 02 ment ranges that can be selected, each of
CO (ppm) P T which appears as a channel on the launch
CO (ppm) 3 4 dialog.

Refer to the HOBO CO logger’s User’s
Manual for the exact measurement ranges
represented by each channel.

Wrap Around When Full

Click Wrap Around When Full to set the logger to record continuously, overwriting the
oldest points when it is full. When full, the logger continues logging until interrupted by
a readout or launch. On readout, the most recent points are read out.

If Wrap Around When Full is not checked, the logger stops when its memory is full.

12 Launching
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Readout log

BoxCar creates an entry in the Readout Log for each saved file
with the following information: file name, logger serial number, Open (=]
header information, start and end date/time, number of points, Lz

shuttle serial number, and deployment number (available for
HOBO H6, HOBO Event, HOBO Thermocouple, HOBO CO, and
HOBO H8 loggers). Choose View Readout Log on the File
menu to view the log using Notepad. The Readout Log can also be
viewed using another text editor.

Pt Satup..
Preferences

& READDUT.LOG - Notepad M= 3
Fie Edt Semch Heb |
File 5/H Description Start Time End Time HofPoints =
CoWhoxcard\I78 jLhe dtF

9994623 178 Jthernn 2hMay 1H:53:39.0 2hMayR1 1h:Sh:31.5 106
c:\boxcard\best.dbf

2606081 Warehouse Environment 15Hardl 16:39:59.0 14Har@1 16:50:26.5 1256
co\hoxcard\I78 cottage diF

211334 178 Cottage Temperature A5Jun@l FZ2:38-00.0 NSJunf1 22:3R:02.0 5 =|
| | Ll/

Synchronizing a Shuttle’s clock

To ensure that loggers are relaunched with accurate time parameters, synchronize the
Shuttle’s clock with the host computer’s clock.

For the HOBO Shuttle, select Launch from the Logger menu. BoxCar connects to the
HOBO Shuttle, synchronizes the HOBO Shuttle’s clock, and displays the battery’s per-
centage level.

For the Optic Shuttle, select Optic Shuttle Readout from the Logger menu. After
data has been read out, BoxCar synchronizes the clock and warns you only if the bat-
tery is low.

Launch and Readout Confirmation

After a successful launch or readout, BoxCar displays the Disconnect Logger dialog.
Simply unplug the logger from the serial cable and click OK.

The Disconnect Logger dialog ensures that the launch or readout takes place cleanly.
This avoids a problem with some computers which use power management subsystems
that power down the serial port, and may stop the logger. Click More Info for more
details.

To disable this dialog box, Click the File menu, select Preferences, and uncheck the
Show Power Management Dialogs item.

Readout Log / Synchronizing Shuttle Clock 17

Reading out data

Reading out your logger

To offload collected data, connect the logger, click the Log-
ger menu and select Readout. BoxCar reads out, displays
the data, then prompts you to save. BoxCar displays the
plot even if you choose not to save. Reading out your logger
stops the logger from logging. To restart logging you’ll need
to click the Logger menu and select Launch.

Reading out your HOBO Shuttle

To offload data from the HOBO Shuttle, EHEEIER:
select HOBO Shuttle Readout from
the Logger menu. BoxCar connects to
the HOBO Shuttle and begins to offload
data files. When the readout is complete,
BoxCar tells you the difference between
the Shuttle’s current time and the host
computer’s current time, then synchro-
nizes the Shuttle’s clock to your
computer’s clock. BoxCar checks the
HOBO Shuttle’s battery and gives you the battery level percentage. BoxCar prompts
you to save each of the data files from the HOBO Shuttle. The File Information dialog is
displayed so that you will know which file is being saved. To view the saved files, select
Open from the File menu and select the appropriate file.

Readout CileR
HOBO Shuttle Readout  Ciil+Rt
Optic Shutthe Readout  Chrl+l

“Note® The: Shuttie's clock was ahead of host computer’s clock by 3 seconds
Loggers lsunched by this Shuts in the past could be ol by that amourt.

It v vt boc 220859 155150

Shuttle battany level iz 1000

Reading out your Optic Shuttle

To offload data from the Optic Shuttle, select Optic Shuttle Readout from the Logger
menu. Connect the Optic Shuttle to the displayed port and press the button on the Optic
Shuttle to offload. The Optic Shuttle’s ShaaTaN
orange LED light will blink and then the
offload of data files will begin. When the
Optic Shuttle offload is complete, BoxCar
compares the Optic Shuttle’s current
time to the host computer’s current time |y was seset to: 2200833 155339

and tells you the difference between the

Optic Shuttle’s current time and the ok ]

computer’s clock, then BoxCar synchro-

nizes the Optic Shuttle’s clock to your computer’s clock. BoxCar also checks the Optic
Shuttle’s battery and warns you only if it is getting low. After this, BoxCar prompts you
to save each of the data files from the Optic Shuttle. The File Information dialog box
will be displayed so that you will know which file is being saved.

“Nole® The Shuttle's clock was ahead of host computer’s clock by 54 seconds
Loggers launched by this Shuttis in the past could be off by that smount

16 Reading out data
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Delayed Start

To postpone logging for up to three months after launching your logger, click Delayed
Start, then enter a specific start date and time in the fields provided. The format you
use to enter date and time will match the format you selected in BoxCar Date/Time
preferences.

When delayed start is enabled, the logger does not start to record data immediately
when you click Start. Rather, you will see the logger flash dimly (approximately every
four seconds) until it reaches the start time specified, then data logging will begin.

Current Enabled Channels
The Current Enabled Channels field shows the channels and measurement ranges that
are currently activated.

Enable/Disable Channels

Click Enable/Disable Channels to select the desired measurement ranges and channels.
A dialog box appears. Click next to a channel to enable or disable the channel corre-
sponding to the desired measurement range. Each channel represents a different mea-
surement range of the attached sensor. Consult the logger’s hardware manual for exact
details on the measurement ranges.

Max points per channel displays the number of
points that will be stored for each channel before the Mos poits oo charned 16259

logger is full (data memory divided by number of en- Chareed Sensan
abled channels). 1 P FlweTCOS0C

Battery Level
Watch the Battery Level gauge to see the remaining

g F knpeTcoizsac
3 T Tempeishes

battery capacity. When the gauge reaches one quar-
ter remaining, we suggest you change the battery,
especially if you plan a long deployment.

Start

Click Start when you are satisfied with the settings. Do not unplug the logger from the
interface cable until BoxCar has indicated that the launch has been completed. Launch-
ing your logger will overwrite the previously recorded data. Confirm a successful launch
by watching for the logger’s LED to blink. Consult the logger’s User’s Manual for more
information on the LED status signals.

Launching 13
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Launching HOBO Hé family loggers

Current State

This displays the text the user en-
tered for the logger’s present state
corresponding to Closed Text or
Open Text.

Close Text

The text entered in the Close Text
box will be stored with the
timestamp for each closing, and dis-
played on the graph. Up to twenty
characters can be typed in this area.

Open Text

The text entered in the Open Text
box will be stored with the
timestamp for each opening, and dis-
played on the graph. Up to twenty
characters can be typed in this area.

Lo H|
I S 12428 —ﬁm s _|
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Help i
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HOBO Hé Launch Dialog Box

Common HOBO Hé6/Event launch features

Deployment

To view the number of times your logger has been deployed, check the Deployment field.
The value in this field always includes the current deployment, and increases by one

every time the logger is launched.

Description

Enter up to forty characters of text in the Description field. This text is sent to the
logger when you click Start and is displayed below the time axis on the graph.

Wrap AroundWhen Full

Click Wrap Around When Full to set the logger to record continuously, overwriting the
oldest points when it is full. When full, the logger continues logging until interrupted by
a readout or launch. On readout, the most recent points are read out.

If Wrap Around When Full is not checked, the logger stops when its memory is full.

Delayed Start

To postpone logging for up to three months after launching your logger, click Delayed
Start, then enter a specific start date and time in the fields provided. The format you
use to enter date and time will match the format you selected in BoxCar Date/Time

preferences.

14 Launching/Common Features
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Launching HOBO Event loggers

Last Event At

While the Launch dialog is open,

it displays the time of the last event.
If an event occurs while the launch
screen is shown, it will display the
time.

Event Name and Event Value

Use the Event Name text box to
describe the type of event being
monitored. This will be displayed on
the Y-axis at readout. The Event

Value is the quantity associated with

one event.

Lockout After Event

HOBO Evere. (€] 139 ONSET Comeude Cop S 21841
Date: 4720097 0321 PM Depioyment 1
Last Event At Wiating

Derription [T 2 the Lo s

Event Name: [L‘Ill.' INCHES OF RAIK

EveniVahe |1

= Acvanced Options . Batiery State: Good

I emp anand vhen full [oveswnie oldast data)

7 Delyed Siat |23 G T == |

I Lockout aller evart | i |

HOBO Event Launch Dialog Box

Select Lockout after event to tell the logger to ignore events for a programmable period
after an event is recorded. This can be set for as short as one second to as long as nine
hours. With tipping-bucket rain gauges, we recommend setting the lockout to one second

to eliminate switch bounce.

When delayed start is enabled, the logger does not start to record data immediately
when you click Start. Rather, you will see the logger flash dimly (approximately every
four seconds) until it reaches the start time specified, then data logging will begin.

Battery State

This field shows the state of the battery. It displays 'Good' if battery has more than 20%
of its capacity remaining, otherwise it will display 'Bad.'

Start

Click Start when you are satisfied with the settings. Do not unplug the logger from the
interface cable until BoxCar has indicated that the launch has been completed. Launch-
ing your logger will overwrite the previously recorded data. Confirm a successful launch
by watching for the logger’s LED to blink. Consult the logger’s User’s Manual for more

information on the LED status signals.

Launching / Common Features 15
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